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Lesson One: Basic Terminology & Methods to Connect to the
Web

Terms in this Lesson: WWW, Browser, Hypertext (HTML), ISP

What is the World Wide Web?

Before understanding Navigator, it might be a good idea to get familiar with the World
Wide Web, also known as the Web or WWW. The World Wide Web is not the Internet
but a part of the Internet containing graphics, multimedia, and text-based information
formatted into pages. Millions of pages which can be accessed and read by selecting
Links embedded within the documents make up the Web.

What is the Internet?

The Internet is a collection of computers connected through hardware and communication
devices to form a network. The computers have the ability to share a multitude of
information and resources other than the Web.

What Kind of Information can be accessed from the Web Pages on the
Internet?

The Web is an excellent resource of information for educators and students. Topics dealing
with curriculum and lesson plan development, collaborative teaching and learning are
among the many resources that can be explored through the Web . Research databases,
holding occupational information, for example, are at our disposal to find information.
Not only are text-based materials built into the Web, but other components to facilitate the
exchange of electronic mail, discussion groups, video clips, and music.

What are Web Pages and how can I view them on the World Wide Web?

A Web page is simply a file encoded with a programming language called Hypertext
Mark-up Language or HTML. The HTML code tells the Web page how to look when
it appears in a browser.

In order to view documents on the Web, you need a browser. A browser or Web client
is a software application which will enable you to interact with and browse files on the
World Wide Web. This is similar to opening a file cabinet drawer and viewing individual
file folders and the information within the folders. Once opened like a file cabinet, a
browser enables the user to skim material on the Web quickly or stop and deeply
investigate particular topics. A person may easily access a page by selecting a highlighted
word or sentence called a hypertext link located on the current page. Hypertext and link
concepts will be described in later activities.

Some of the more commonly used browsers are Netscape and Internet Explorer both of
which function on Windows 95 or 98, and Macintosh machines.
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What you need to access the Web

Computer with Browser and Network Software:

PC

Browser software: Netscape or Internet Explorer.
OS: Windows 95 or 98 with Dial-up Networking software.
RAM: At least 16 MB Ram for Windows 95. In order to surf the Web loaded
with graphics and multimedia, 32 MB is preferable.

Macintosh

Browser software: Netscape or Internet Explorer
OS: System 7.6 or higher with MacTCP or TCP software
RAM: At least 16MB Ram. In order to surf the Web loaded with graphics and
multimedia, 32 MB is preferable.

Internet Service Provider (ISP): A company which connects your computer to
the Internet. ISP's will include communications software, some Internet tools, an e-
mail account and address with the service. Sometimes disk space is included for you to
publish a Web page. While shopping for an ISP, look for services which charge a flat
monthly rate rather than by the hour. Depending upon the provider and service offered,
some ISP's may charge anywhere between $9.00 to $20.00 per month.

Modem: The most commonly used device to access the Internet are modems offering
various speeds measured in kilobits per second (Kbps). The speeds are: 14.4 Kbps,
28.8Kbps, 33.6Kbps, and 56Kbps. A 28.8 baud modem or faster is recommended to
connect to the Internet.

Other types of hardware connections: The following connections offer a direct
connection to the Internet

Cable Modems: Local cable companies are now offering cable modems with speeds
100 times faster than 56Kbps. Cable modems cost approximately $30.00 per month
and are used by people who frequent the Internet for high-end use.

ISDN: Moves at four times the speed of a 28.8 Kbps modem. ISDN uses two
separate channels enabling people to use their telephone while connected to the Internet.
ISDN lines cost approximately $100.00 per month and are used by people who
frequent the Internet for high-end use.

Ti: A T1 line operates at 1,544,000 bits per second (1.544 Mbps) and can move 1
MB of data in less than 10 seconds. This is about 60 times faster than a standard
modem. A T1 line costs approximately $75,000 per year and is used by Corporations
and Universities.
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Hardware Connections (Con't)

T3: A T3 line operates at about 44,736,000 bits per second (44.3)Mbps and is 1,550
times faster than standard modem. This speed permits transmit and receive of real time,
full-screen, full-motion video. T3 lines cost approximately $200,000 per year. They
make up the backbone of the Internet and are also used by large Internet Service
Providers.

What is Netscape Communicator?

Netscape Communicator is a powerful application composed of networking tools to
complete a variety of on-line tasks. The tools or components will enable you perform the
following:

Examine Web pages using Navigator.
Design your own Web pages through Composer.
Use Communicator's Messenger program to send and receive e-mail, and to join a
multitude of Internet newsgroups.
Explore Communicator's Chat services to talk with people on the Internet in real-time.
Take advantage of Calendar, Communicator's time management program enabling
you to schedule appointments and create task lists. An organization can use Calendar to
perform group scheduling activities.

How Can I Purchase Netscape Communicator?

Netscape Communication Corporation has made Netscape Navigator Stand-Alone
Edition and the Standard Edition of Netscape Communicator completely free to all
users! At one time, Netscape was free only to academic institutions while others had to
pay for the product after the free evaluation period. Methods to get Netscape 4.5 will be
discussed at the end of the lesson.
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Lesson Two: The Navigator Window

Terms in this Lesson: Home page, Preferences, Toolbars

The page that first displays in the Web browser is a Home page and it is a starting place
to begin exploration of a site through links that point to other areas of interest.

When you start Netscape you are taken to the Netscape home page by default. Later in the
lesson, we are going to change the default home page to another site.

'2.E*

Window Title Bar Navigation Toolbar Netscape Logo

ersonal Toolbar enu Bar Location Toolbar

sta
x

1\,,V s4z

Admissions

Financial Aid

Student Services .
News & Calendar

Dean's Message
Computing

6 t

rtments
Offices, Centers, &

Institutes
Grants & Research

Faculty

Alumni

[Adam:tura] Pautool jCsr.osnr41 [Dean'',De-wirnergatil .1711jw,

[Flews] !Officer...Centers, lerstra.. .e0 [Student ...trace4 ITetmclel

Comments about dna web e se wek sue and shouli adoiressed to Gal)

ecur' y Indicator age Display Area Off-line Qndicator

Pro ress Bar Status Message Area

4
8

Component Bar

BEST COPY AVAILABLE



Navigator Toolbars and Menus

The Navigator window for Netscape Communicator version 4.5 includes the following
toolbars and functions:

Window Title Bar

Menu Bar

Navigation Toolbar

Displays the title of the Web page being viewed.

Menus containing all of Communicator's tools.

File Menu. For manipulating files.
Edit Menu. Basic file editing tools and preferences
to change the appearance of Communicator and to set
up e-mail information.
View Menu. Options to change the manner in
which Netscape pages are viewed.
Go Menu. Tools to navigate the Web.
Communicator Menu. To select and open
different Communicator components.
Help menu. For help.

Contains the most frequently used menu items.

Back. Jump back to the previous selection.

Forward. Jump forward to the next page or
document.

Reload. Refresh the currently loaded document.

Home. Return to the default startup page.

Search. Opens a page where you can search for
information on the Web.

Netscape. Click this button to create a
personalized start page for Communicator through
Netscape's portal Web site, Netcenter.

Print. Print the current document.

Security. Displays information about
Communicator's security features.

Stop. Cancels the process of loading an incoming
document.
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Navigation Toolbars and Menus (Con't)

Netscape Logo

Location Toolbar

Personal Toolbar

Page Display

Security Indicator

Progress Bar

Status Message Area

Off-line Indicator

Component Bar

Animation of shooting stars to indicate that a page transfer is
in progress. The logo also acts as a direct link to the
Netscape Web site after it is selected.

Indicates the address of the page currently viewed. Invites
one to enter addresses of new pages to open.

Your own customizable toolbar. This toolbar is not yet
available with the Macintosh version of Netscape.

The largest portion of the Netscape window displaying Web
pages.

Provides information about the page's security status.

Displays the percentage of a document transfer.

Displays information about a document as it is being
downloaded from a server to your browser. After a
document is loaded in the page display area, a message
indicating Document Done will appear. If a particular link
is highlighted with the mouse, the address of the selected site
will be viewed here.

Switches between on-line and off-line mode. If your ISP
recommends the IMAP protocol for e-mail, the off-line
feature will enable you to download and read e-mail while
disconnected from the Internet.

Gives access to the most commonly used components
which make up the Netscape Communicator program. The
components include: Navigator, Messenger's Mailbox,
Messenger's address book, and Composer.

Changing the Default Home Page

A Home Page is the first page that displays in a Web browser such as the Netscape site. A
home page also serves as a page that somebody has published on the Web. Your own
home page could be designated as the default home page.

Hands-On Activity: Description:

1. From the Menu bar, select Opens a menu containing editing tools and
Edit. preferences to change Netscape settings.

2. Select Preferences. Opens the Preferences Dialog box.

3. On the left side of the window, Opens Navigator dialog box.
select Navigator.

6
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Changing the Default Home Page Activity (Con't)

4. Under Home Page, position
the mouse in the Location
dialog box and click.

To enter information in the window.

5. Type: To change the default home page to
http://www.temple.edu/education the College of Education at Temple

University.

6. Click OK To accept and save the change.

7. From the Navigation Toolbar, To load the new default home page.
Click on Home.

Helpful Hint: Preferences contain a number of features to enable you to change the
characteristics of Netscape. Other Preferences features will be discussed in a later lesson.
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Lesson Three: Navigating the Web

Terms in this Lesson: Domain Name, HTML, Hyper links, Hypertext,
URLS

Hypertext Markup Language (HTML)

Documents on the Web are simply text pages which contain code to control the page
format. The code is called hypertext markup language, also known as HTML. As a
result, documents on the Web are called hypertext pages. A hypertext page has the
ability to include images, sound, video, and links to navigate to other pages.

Hyper links (Links)

A link, sometimes called hyperlink, is simply an address (or URL) which is encoded on
the page to link to text or graphics located on another part of the same page or to a totally
different site. URL's, also known as Uniform Resource Locators will be described later.

How Can I Identify a Link?

Text links can be easily identified on a page since the word or phrase is underlined and
highlighted in an outstanding color, typically blue. When the mouse pointer is positioned
over a link, the link's address (or URL) displays in the lower status message area of the
browser window and the pointer changes to a hand. The color of followed links will
change as a reminder of the places you had visited. Images can also act as links to connect
the user to another page.

How to View a Web Page

We will follow some links on the Netscape home page to familiarize ourselves with Links
and the Navigation toolbar.

Hands-On Activity:

1. Click on the N Icon (Netscape)
located in the upper right window.

Description:

Loads the Netscape Netcenter Home Page.

2. Click on the Browsers Displays the Netscape Products page
Link located toward the upper offering browser software.
part of the page.

3. Click on the Download Displays Netscape's download software
Link located under the Computing page.
& Internet column to the left.

4. From the Navigation Toolbar, Click Returns to the Netscape Products page.
on the Back button.

5. Click on the Forward button. Returns to download software page.

Challenge: Take a few moments to explore some other links on the Netscape Home
Page. Tunnel your way through the web by selecting links. Use the toolbar to go forward



and backward. Notice that the colors of links you had previously visited will change. This
serves as a reminder of the sites you had previously visited.

The Uniform Resource Locator

Like a spider web, the entire Web is intertwined and could be navigated by hopping from
one site to another through the selection of hyperlinks. Often, you will wish to go directly
to the web page of your choice rather than skipping through a multitude of links. The
Uniform Resource Locator (URL) is the addressing scheme used by the Web. The
URL pinpoints the location of documents and other information on the Web so that
Netscape will load them into the browser window. Typing in the document URL takes
you directly to the Web page of your choice. The following is the URL for the Netscape
home page:

http://

http://www.netscape.com

an Internet protocol which stands for Hypertext
Transfer Protocol . It is the standard for
transferring HTML pages and is used in URL's that
point to a resource on the Web. HTTP is the protocol
most often used since Web pages are often accessed
the most.

w w w indicates the name of the server where the file to be
transferred to your Web browser is stored.

netscape sometimes identifies the company or organization
managing the server.

corn identified the kind of organization operating the
server. In this instance, a commercial organization.

The first three parts (www.netscape.com) identifies the computer's domain name which
distinguishes it on the Internet. Every server on the Internet must have a unique domain
name.

Shortcuts

Since most URL's lead to Web pages, shortcuts have been programmed into newer
versions of Navigator.

While entering a URL into the Location Window, the word HTTP can be omitted.

www and com can be omitted when they are included in the same address for a
particular site. Simply type the name which identifies the company, typically the middle
word. To display the Netscape home page, type netscape in the Location toolbar
rather than www.netscape.com.

While typing a URL in the Location toolbar, Navigator attempts to complete the address
for you based on the pages your previously visited.
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Helpful Hint: There are many other protocols other than HTTP which link to other
resources on the Web. These protocols will be discussed in the advanced lesson.

Methods to open a URL

Netscape offers several methods to open a URL. Some of these methods include:

Using the Menu bar to open a URL
Typing the URL in the Location Toolbar

Using the Menu bar to open a URL

Hands-On Activity: Description:

1. From the Menu bar, Select File, Open. Displays the Open Page
Page. Select Location in Navigator window.
from the drop-down menu.

2. Type teachnet and press [Enter]. Displays resources for
K-12 school teachers.

Helpful Hint: Positioning the mouse in the location window and Double-clicking
will activate an edit cursor to enable you to edit the displayed URL. This is handy if you
wish to correct a typo or insert additional information. Triple-clicking in the location
window will mark the entire URL. The URL will be erased and replaced by your new
entry.

Typing the URL in the Location Toolbar

Hands-On Activity:

1. Triple-click in the Location Toolbar.

Description:

Highlights the entire URL
in the Location Toolbar.

2. Type voctech.miningco.com The previous URL is replaced by
and press [Enter]. the new entry and Vocational &

Technical Education and Careers
home page is displayed.

Challenge: Take some time to explore some of the interesting resources contained in this
site. Later in the lesson, you will learn how to find interesting sites such as
votech.miningco.com in order to find information.

Transfer Problems

At times, Netscape will have difficulty connecting to a particular site in order to download
the requested information. While trying to connect to a particular site, you may notice that
Netscape does not make an attempt to load the page. The site could be overworked and it is
recommended that you try later. An error message will occur if the URL was typed
incorrectly (watch out for typos!). The web server or web page was taken off-line either
permanently or for maintenance.
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Finding Text on a Web Page
The Find feature will quickly locate a particular word or phrase located within a Web page.

Hands-On Activity

1. From the File menu, select Open.
Page. Select Location in
Navigator from the pull-out menu.

2. Type www.healthatoz.com
in the Location Dialog box.

3. Click on Alternative Medicine.
Select Aromatherapy. Select
Aromatherpay - What is it?

2. From the Edit menu, click on
Find in Page.

3. In the Find What field, enter
therapeutic.

4. From the Edit button, select
Find Again.

5. Continue to select Find
Again from the Edit menu until Search
String Not Found! appears

6. Click OK to remove the prompt.

7. Click on the Find window Close box.

8. Remain at the Aromatherapy -
What is it? page.

Description

Opens the Open Page Dialog box.

Displays the Source for Health
and Medicine Page.

Displays information about Armatherapy.

Displays the Find on Page dialog box.

Enters the term you want to find.

Will locate the next occurrence of the
word entered.

Continues to find occurrences of the word
until no more can be located.

Closes the window.

Closes the window.

Viewing the Document Source

In order for text files to be displayed through a Web browser, the pages must be coded
using a special language called Hypertext Markup Language usually known as HTML.
The following activity demonstrates a method to look a Web page's source code using the
Aromatherapy What is it ? page.

Hands-On Activity Description

1. From the Menu bar, select .
View. Select Page Source.

Displays the page with hypertext markup
language (HTML).

Challenge: Take a few moments to scroll through the source code while comparing it to
the page displayed in the browser window.
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Lesson Four: Organizing Your Information on the Web

The History List

When you follow a series of links, it can be very difficult to remember how to get back to
a particular site of interest. Fortunately, Netscape keeps track of all of the sites you
previously opened visited in a History list. The History List is a record of previously
opened Web pages that were opened by selecting a trail of links or opened directly by
entering a URL.

From the Navigation toolbar, click and hold the Back button for a list of pages to
which you can go back.

From the Navigation toolbar, click and hold the Forward button for a list of pages
to which you can go forward.

From the Menu bar, select Go. A list of all of the pages you can go back and
forward to are listed at the bottom of the Go menu.

Click the arrow to the right of the location window for a list of URL's you previously
typed. This option is not included with the Macintosh version of Communicator.

From the Menu bar, select Communicator, Tools. Select History to open the
most comprehensive history list. Pages visited in the current session and in recent
previous sessions will be visited. The Macintosh version only lists pages visited in
the current session..

It is important to know that the first four options do have their limitations. They display a
series of pages visited in the current session and one thread of a followed link. If you go
back a page and select a different link, the new path will replace the old one. The lists
will disappear after you quit Communicator. The last option, proves to be more
comprehensive.

Viewing the History List Through The Navigation Toolbar

The following method to retrieve a previously visited site saves more time than continually
clicking the back button.

Hands-On Activity: Description:

1. From the Navigation Toolbar, position
mouse on the Back Button and
press down..

Displays a drop-down menu listing
URL's that you had typed in.

2. Click on any visited site. Loads and displays the sites to
which you can go back and visit.

3. From the Navigation Toolbar, hold Loads and displays pages to which
down the Forward Button. you can go forward.

12
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The Go Menu

Hands-On Activity:

1. From the Menu bar, select Go.

Description:

Lists a series of pages visited in the
current session to which you can go
back and forward. .

Viewing the History List Through The Location Window

Hands-On Activity:

1. Click the arrow to the right
of the Location Toolbar.

Description:

Lists all of the URL's previously
visited.

Viewing the History List Through The Communicator Menu

Hands-On Activity:

1. From the Menu bar, select the
Communicator menu. Select Tools,
History.

2. Double-click any listing.

Description:

Lists a series of pages visited in the
current session and in recent
previous sessions.

Opens the selection in a new
Navigator window.

Challenge: What are the differences between the History list in the Communicator
menu and the others investigated?

Sorting and Searching the History List

A sort and search feature for the History list is available to Windows users. The following
activities describe methods to search and sort your list by many different criteria.

Hands-On Activity:

1. From the Menu bar, select Communicator.
Select Tools. Select History
from the pull-out menu.

2. Select the View menu

3. From the Edit Menu,
Choose Search History List.

Challenge: Experiment with the various options.
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Set the Expiration Date for the History List Through the Preferences Option

Since the history list takes up space on your computer hard drive, Communicator must
periodically erase the list. On the Macintosh, the list is always emptied when you quit the
program. The following instructions will help you determine how often the history list is
deleted and when followed links expire.

Hands-On Activity:

1. From the Menu bar, select Edit.
Select Preferences.

2. From the left category window,
select Navigator.

Click on the Clear History
button located under History.

4. Change the number of days in which
the history list will expire next to:
Pages in History will Expire after
(for PC users) OR
Visited Links will Expire After
(for Mac users)

Preferences

Description:

Displays the Preferences dialog box.

Displays the Communicator startup
settings.

To expire the history list and all
followed links.

Will expire the history list on the day
and the time period you selected.

The Preferences dialog box contains a number of options to help you control the
appearance of Communicator and the manner in which it functions. The Navigator
option previously discussed offers the following features:

Request Navigator to start with a blank page, the home page of your choice, or the last
page visited.

Set the expiration date of history lists.

Clear the history list and expire visited links.

Clear the list of visited sites on the location bar.

Changing the Appearance of Links

The color of visited and unvisited links and whether or not they are underlined can be
changed through Preferences.

Hands-On Activity: Description:

1. From the Menu bar, select Edit. Displays the Preferences dialog box.
Select Preferences.
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2. From the left category window, Select Displays the Appearance settings.
Appearance.

3. Click on Colors. Displays the Color settings.

4. Click on the Unvisited Links: field. Displays a color palette.

5. Click on a orange color and click OK. Selects the color orange as the new
color for unvisited links.

6. Click on the Visited Links: field. Displays a color palette.

7. Click on a red color and then click OK. Selects the red color as the new color
for Visited Links.

8. Click OK.

15
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Bookmarks

Navigator has created a more permanent solution to recalling previously visited sites of
interest. The Bookmark option makes it easy to permanently save sites of interest until you
decide to delete them.

What exactly is a bookmark? A bookmark is simply a marker which stores the
address (URL) of a page so that you can get back to it easily. Bookmarks are saved in a
file stored on your computer hard drive and the menu is accessible from two places for
Windows users:

On the left side of the Location toolbar
Under the Communicator menu from Menu bar.

Macintosh users may find the Bookmark menu under the green Bookmark icon located to
the right of the Go menu.

Setting a Bookmark

The following activities will enable you to permanently mark sites of interest found through
the Web.

Hands-On Activity: Description:

1. Display the www.ed.gov site in your
window.

2. Go to the Bookmark menu
to the left of the location
toolbar OR the Bookmark
menu under Communicator.
Select Add

3. Click on the Bookmarks menu
to see the U. S. Department of
Education bookmark

Adds a bookmark for the U. S. Department
of Education site.

Displays the Bookmarks list. The U. S.
Department of Education is viewed and
loaded into Netscape.

Challenge: Set a bookmark at the www.temple.edu site. Return to the www.ed.gov site
through the bookmark menu. Go back to the Temple University site through the Bookmark
menu.

Other Methods to set a Bookmark

If you wish to retain a Bookmark from a previously visited session, select the URL you
wish to Bookmark from the History list located under Communicator, Tools, History.
Choose Add to Bookmarks from the File menu.

Open the Bookmark menu located to the left of the Location toolbar. Select Edit. Drag
a hyperlink from an open page to end of the Bookmark window.

Drag the link over the Bookmarks Icon and release it to add the displayed page as the
last item in the bookmarks list.



Organizing Bookmarks

The Bookmark list can be quite lengthy and extensive. There are several ways you can
organize your Bookmarks so that they can be accessed more easily. One way to organize
them is to arrange them alphabetically. Another method of organization is to place them
into topic oriented folders.

Hands-On Activity: Description:

1. From the Bookmarks menu,
select Edit Bookmarks. For
the Macintosh, select Bookmarks
from the Communicator menu.

2. Click on the U. S. Department
of Education . Keep finger pressed
on mouse. While highlighted, move
the selection to another area on the
list

Displays the Bookmarks window
containing all of your bookmarks and
folders and features to manipulate
your bookmarks

Changes the position of a URL.

Challenge: Alphabetize the remaining bookmarks.

Creating Folders for Bookmarks

As you add bookmarks to the list, the screen will fill. To better categorize and organize
your URLS, you can group bookmarks in folders which will appear in the Bookmark list
as sub-menus.

Hands-On Activity: Description:

1. From the Bookmarks menu, select Selects the URL which will
Edit Bookmarks. Click on the icon
directly above where you want to
insert the new folder.

be moved under a new folder.

2. From the File menu, select New Creates a new folder.
Folder.

3. In the Name Field, type Enters the folder name.
Government.

4. Click in the Description Field Enters the folder description and
and type This folder

contains government related
the folder in the Bookmarks list.

links and click OK
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Creating Folders for Bookmarks Activity (Con't)

5. Click on the U.S. Dept. of Ed.
bookmark and drag it to the
Government folder.

6. Close the Bookmarks window.

7. From the menu bar, select
Bookmarks. Drag to
the Government Bookmark.

Places the U. S. Dept. of Ed. link in
appropriate folder.

Returns to the Web page.

The link appears with a right triangle
next to it indicating that it is a folder.
Selecting the folder displays its
contents.

Challenge: Create a "Vocational Education" folder. When you have finished, drag any
links pertaining to Vocational Education into the folder.

Helpful Hints: A folder can be assigned to be the default place where all new
Bookmarks are stored. From the Bookmarks window, select the folder. From the View
menu, select Set as New Bookmarks Folder.

Searching and Sorting Bookmarks

1 From the Communicator menu,
select the Bookmarks. From the
Edit Bookmarks menu , select the
View menu.

2. Select By Location

3. Select Ascending or Descending.

Renaming Bookmarks

Displays the View menu.

Arranges bookmarks and folders
alphabetically by URL.

To sort in alphabetical or reverse
alphabetical order.

The name of a bookmark can be changed to whatever you like.

Hands-On Activity: Description:

1. From the Bookmark menu Displays.the contents of the
double-click on the Government
folder

Government folder.

2. Click on the U. S. Selects the Bookmark to be renamed.
Dept. of Ed. Bookmark

4. Select Bookmark Properties Displays the Bookmark Properties
dialog box. or Get Info for Mac users

5. Click in the Name: field,
and type a your name.

Changes the title of the bookmark
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Renaming Bookmarks Activity (Con't)

6. Return to the Bookmark list. Note the name change.

Challenge: Using the instructions listed above, select bookmarks. Change the names.

Deleting Bookmarks and Bookmark Folders

To avoid a cluttered bookmark list, bookmarks should be deleted when no longer needed.
Individual bookmarks and bookmark folders are deleted in the same manner.

Hands-On Activity:

1. Click on a bookmark within the
Vocational Education folder.

2. Press the DELETE key.

Description:

Selects the bookmark to be
deleted.

Removes the bookmark from the list.

Challenge: Delete the Vocational Education Bookmark folder.

Adding Separator Lines

Bookmark lists can be visually organized by adding separator lines between folders and
files.

Hands-On Activity:

1. Click on the folder of your choice

2. From the Bookmarks Window, select
File.

3. Click on New Separator.

Description:

Selects the item you want the
separator line to appear below.

Displays the File menu.

Places a separator line below the
folder of your choice.

Helpful Hints: You may have the need to backup your bookmarks and place them on
another computer. Netscape contains features to enable you to save your bookmarks and
restore them to another computer hard drive.

Saving a Bookmarks File

Open the Bookmarks Window
From the File menu, select Save As.
Select the location, most likely your floppy disk, where you want to save the
bookmarks file.
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In the Filename field, enter the name of the bookmark file. Be sure to retain the .html
or .htm extension.
Select Save.

Importing Bookmarks to your computer hard drive.

Open a Web page.
Select Save As from the File Menu and save the page to your hard drive as an Html file.
Open the Bookmarks window.
From the File menu, select Import.
Select the HTML file that you saved, and click Open.

Lesson Five: Saving and Printing A Web Page

Terms in this Lesson: GIF, JPEG, In line images

Before learning to save an image, it must be made clear that images and text that appear on
Web pages are the property of the owner of the page. Copying images violates copyright
laws and can only be done after obtaining the approval of the owner of the page.
Fortunately, there are numerous public domain sites from which graphic images can be
obtained.

Saving a Web Document as Text

Web documents can be saved and incorporated into a word processor such as Word or
WordPerfect. The page must be saved as plain text in order to eliminate HTML codes.
Netscape has a built in feature that allows you to save Web documents as plain text. It also
creates a name for you that is extracted from the title of the Web document.

Hands-On Activity: Description:

1. Select a page with text.

2. Click on Save As from Displays the Save As dialog box.
the File Menu.

3. From the Format Box,
select text from the drop down
menu

4. Click on the arrow in the Save in:
area and select Desktop

5. Type a name for your document. Do
not include any htm or html extensions.

6. Click OK.

Selects the text option.

Selects the desktop as the place to
save the Page.

To change the name of the document

Helpful Hint: If you are connected through an ISP and your phone bill's are mounting,
go off-line to read your Web pages. Simply save the file as HTML rather than text. Go
off-line to read the page through your browser.
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Saving a Web Document in HTML Code

The following activity will enable you to save a Web file to your local hard drive to view
during times you are off-line.

Hands-On Activity: Description:

1. From the Location Toolbar Opens American Culinary Federation
type www.acfchefs.org <enter> site.

2. Click on Save As from Displays the Save As dialog box.
the File Menu.

3. From the Format Box,
select HTML from the drop down
menu

Selects the HTML code option.

4. Click on the arrow in the Save in: Selects the desktop as the place to
area and select Desktop save the Page.

5. Click OK.

Opening a Web Document as a Local File

Hands-On Activity: Description:

1. From the File menu, Select Open .

Select Page in Navigator from the
pull-out menu.

2. Click the Desktop.

3. Locate and select the American
Culinary Federation page.

Opens a dialog box listing locally
stored files on disk.

To display files saved to the desktop.

Opens the site locally from your
computer hard drive.

You may have noticed that when you saved Web pages through text or html, the graphics
are not retained. Instead, question marks located in little windows take the place of the
graphic file. This is because graphics and text are saved as different files at the Web site.

225



Saving Images

Pictures that are displayed on a Web page are known as inline images. Navigator displays
inline images in two file formats: GIF and JPEG. JPEG images contain tones and can be
photo quality causing their file sizes to be typically larger than GIF. GIF images are more
commonly used on the Web due to their small file size and download faster.

Hands-On Activity: Description:

1. Click in the Location: Displays the NASA home page.
area and type www.nasa.gov

2. Click on an Image. Displays the image.

3. Position the mouse over the image. Displays a shortcut menu.
and right-click. Hold down
the mouse button for Mac users.

4. Click on Save image As

5. Click on Desktop in the Save in:
area.

Displays the Save As dialog box.

Tells Netscape where to save the
image.

Interesting sites to locate and download images will be discussed later in the lesson.

Printing Web Pages

Sometimes, only a hard copy of information from the Internet will be needed. A document
from Netscape may be printed. A Web page along with graphics may be directly output to
the printer

Hands-On Activity:

1. Open a Web page.

2. From the File menu,
select Print or

Select the Print button from
the Netscape Menu Bar

To print page.

22 26

Description:



Lesson Six: Searching the Web Through Basic Search
Techniques

What are Search Engines?

The search engines are databases enabling people to search for any topic such as on-line
publications, stocks, pictures, and other archives of information. Many engines now
contain predefined categories for those who do not need to search for a specific topic.
These categories include: arts, education, health and sports.

Where Can I Locate Search Engines on the Web?

Netscape provides amazing tools for gathering information on the Web. The Search
button located on the Navigation Toolbar takes you to the Internet Search page at Netscape
Corporation's Web site providing a listing of database search engines related to Internet
sites scattered around the Web.

How Do Search Engines Find Information?

Information on the Web changes on a daily basis and it is the responsibility of those people
who maintain Web sites to update the database along with their categorized listings . Some
search engine sites use robots (sometimes called crawlers, spiders, or worms) to comb the
Web on a daily basis in order to find new information to place in their databases.
Databases maintained by Robots enable people to search for very specific information.
While robot-compiled site may contain categorized listings, the listings are manually
updated by people. In addition to robots and people who manage search engines, anybody
who publishes a Web page has the ability to register their Web site with the search engine
of their choice. The Web, indeed, is a dynamic process.

Popular Search Engines

AltaVista: Extremely fast and powerful search engine having the ability to find
obscure facts. This database contains a spider (named Scooter) which roams the Web
collecting six million Web pages a day.

Dejanews: This search engine is specifically designed to handle the task of searching
for information within newsgroups. About 50,000 Newsgroups exist and each one is
devoted to a specific topic such as business, computers, recreation, science, etc.
Newsgroups somewhat resemble electronic bulletin boards accessed by millions of
people providing more up-to-date information.

Excite: Offers good plain-English searches (entering a basic question in a search
using a unique keyword will yield pretty good results) and known for locating current
news articles and travel information.

HotBot: Ease of use in searching for multimedia files.

InfoSeek: Handles plain-English queries well and has an excellent topic directory.
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Popular Search Engines (Con't)

Lycos: Includes excellent Web-site reviews and has an excellent multimedia search
feature.

Meta Crawler: One query will search multiple search engines through Metacrawler's
metasearch services. This can be a real time saver.

Yahoo: Has the best and most detailed Web directory. This is an excellent choice for
exploring a subject to find out what is available on the Internet.

Search Engine Performance: Important Facts

Search engines have their strong and weak points. Always select the right search
engine for the job.

Search engines include great on-line help features. Always read the instructions.

Web searches can be a challenge even for the best on-line searchers. Learning to come
up with the best keywords for your Web searches takes time and practice.

Always use unique keywords. Ask yourself, for example, "What unique keyword
would be included in the page to which I am searching?" Include those words in your
search.

Know when to use caps in your search. When in doubt , always use lowercase
text in your searches. With lowercase, the search engine finds both upper and
lowercase results. When using upper case text, the search service finds only
upper case. Use upper case when including person's name, a geographical location,
book, or movie title in your search. Doing this will greatly reduce the number of false
drops, which are pages containing the words you included in your query but totally off-
base.

Do not assume that just because information is on the Internet, it is accurate. When
examining your results, always consider the fact that anybody can publish something
on the Internet. Ask yourself who created the information and the motivation behind it
if possible. The date the material was last updated is always a factor to keep in mind
when checking for the accuracy of its contents.

Do not assume that the Internet knows everything. Information may be buried so deep
on the Net, it may be difficult to locate or it may not exist at all. Know when to stop .

and seek assistance from other sources such as almanacs, encyclopedias, or your local
librarian.

Search Topics of Interest

Vocational Education
Computer Aided Drafting Instructional Materials
Plasma Arc Welding
Your own occupational specialty



Searching the Web Using Yahoo's Categorized Listings

Yahoo maintains a very detailed Web directory making it a better choice to search for a
subject to find out what is available on the Internet.

Hands-On Activity: Description:

1. From the Location toolbar, Displays the Yahoo search page.
type www.yahoo.com

2. Click on the Education topic in the Displays a list of education subtopics.
viewing area of the window.

3. Click on K-12 Displays a list of K-12 subtopics.

4. Click on Teaching Displays a list of sites in the form of
links which are related to resources
for teachers.

Challenge: Comb the categorized listings to find topics relative to your own occupational
specialty.

Searching the Web for Pictures using Lycos

Lycos is an excellent search engine for locating multimedia files. These files include
photographic, clip art, video, sounds, and music. Lycos makes this process easy by
providing a Pictures and Sounds option on the main search form.

Hands-On Hands-On Activity Description

1. From the Location Window, type Loads the Lycos search engine.
Lycos.

2. Under the Advanced Search Displays the Pictures and Sounds
located at the left column, click on page.
Pictures and Sound.

3. At the bottom of the page, type Lycos will search the web for
Welder in the search window. Click pictures of welders.
Pictures to the right of search the
web for: Click Go Get It.

4. Click on any link. Displays a picture of a Welder.

Challenge 1: Go back to display the Lycos Pictures and Sounds page. Rather than
searching the web for pictures of a welder, search the Image Gallery for a Welder.

Challenge 2: Find pictures relative to your own occupational specialty.



Searching the Web Using Excite's Plain English Question Search
Feature

Many search engines such as Excite developed techniques to find what you want based on
a simple question using words or phrases that expresses the idea or concept. Exact
keywords and punctuation do not have to be considered. This concept-based (as opposed
to keyword) approach to searching is called Intelligent Concept Extraction (ICE). Excite
will search for sites containing not just the words typed, but also related ideas and
concepts. Although Exite's database is half the size of Altavista's and not updated as
frequently, Excite remains a good search tool worth using.

Hands-On Activity: Description:

1. Click on the Search Button

2. Click on the Excite button.

3. Type Where can I find information
about Adult Education?

4. Click on the Search button located
under the Navigation toolbar.

5. Scroll through the list of results
noting the title of each page.

6. Click the Next Results button
at the bottom of the screen.

7. Go back to page one of the search
results.

8. Look for and select the MyBookworm
the Adult and Continuing Education

9 Go back to page one of the search
results. Click on Search for more
documents like this one listed under
the MyBookworm title.
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Displays the default search engine
page.

Displays the Excite search page.

Retrieve information about adult
education.

Starts the search engine. In a short
period, the results will be displayed.

Displays the second page of results.

Lists the first page of Excite's Adult
Education search results.

Displays the first page of New
New England's adult education
resources site.

All pages referenced to the
MyBookworm site will be
gathered and displayed.



Examining Results

Using Plain-English Text searches typically renders a good number of hits. Some search
engines will rank the results in terms of relevancy with the most relevant listed first and
those that are less relevant further down the list. Search engines sometimes do not
give accurate results:

Sometimes, the content of web pages retrieved will not mention the keyword used,
although it may have been mentioned in the accompanying description. Sometimes the
content will have the keyword listed but not the description

Sometimes search engines return too much information or irrelevant information.
What'did you notice with the results of our search on Adult Education?

Searching the Web using AltaVista

AltaVista is among the search engines which will enable you to use simple schemes to
return more relevant hits. AltaVista is an extremely large database (approximately 300
gigabytes of data) managed by a spider (named Scooter) which constantly roams the Web
collecting about six million Web pages daily.

AltaVista's Basic Search Tips

The following serves as a guide to basic search techniques.

Scheme 1:
Action:
Example:
Result:

Scheme 2:
Action:
Example:
Result:

Scheme 3:
Action:
Example:
Result:

Scheme 4:
Action:
Example:
Result:

Scheme 6:
Action:
Example:
Result:

To find documents through the use of a Plain-English question
Type the question in a smaller search box.
What companies offer computer-based training software?
Companies offering computer-based training software will be listed.

To find documents that exclude certain text
Preface the word to be excluded with a (-) sign
+Islands -Virgin

The Virgin Islands will not be included in any documents.

To search for multiple words for phrases, any one of which may be present
Type the words or phrases separated by spaces between the terms.
Learning Education
Searches for documents containing the words learning or education

To find documents containing all of the specified words or phrases.
Type the word AND between the search terms.
+Mary +Lamb
Finds documents with both the words Mary and Lamb.

To find a specific phrase
Place quotes between the phrase
"Distance Learning"

Finds documents that contain the phrase Distance Learning.
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Altavista's Basic Search Tips (Con't)

Scheme 7:
Action:
Example:
Result:

Scheme 8:
Action:
Example:
Result:

Scheme 9:
Action:
Example 1:
Result 1:
Example 2:
Result 2:

To find all forms of the same word
Type two asterisks ** after the word
Weld**
Will yield words such as weld, welder, welding, welded, welds

To find items with the same prefix
Type an asterisk * after the prefix
Comput*
Searches for topics such as computer, computing, and compute.

To search for documents within the search engine field (Field Search)
Preface a word or phrase with the word text or title
text: "training materials for educators"
Searches for the text in the body of the Web page
title: "Resources for educators"
Searches for text that is part of the title

Refining a search using simple expressions through the Alta Vista Search
Engine

A search can be refined through the use of symbols to include (+) or exclude (-) specific
words in your search topic.

Hands-On Hands-On Activity

1. From the Location Window,
type, altavista

2. Click in the Search the Web field
and type the following phrase:
recipe cookie +oatmeal -raisin

Hands-On Hands-On Activity

1. Return to the Alta Vista home page.

2. Click in the Search the Web field
and type the following phrase:
"vocational education" +training

Description

Displays the Alta Vista Search page.

Searches for documents containing
the recipes for oatmeal cookies
without raisins.

Description

Display the Basic Search form.

Searches for documents containing
the phrase vocational education
training must appear in the
results.

Multiple Search Techniques

The Alta Vista basic search features supports a search for multiple words or phrases.



Multiple Search Techniques Activity (Con't)

Hands-On Activity

1. Go to the Alta Vista search engine
and type the following:
+"New York" +museum
-"Metropolitan Museum of Art"

Description

Will list all New York museums
except the Metropolitan Museum
of Art

Challenge: Try searching for information relative to your own occupational specialty
Using the (+) (-) operators. Experiment with the other schemes listed under Alta Vista's
Basic Search Tips.

Using the Metacrawler Search Engine (www.metacrawler.com)

The Metacrawler search engine is based on a metasearch service invoking a number of
search engines work on a search request. While performing a search, Metacrawler
explores the following engines: Alta Vista, Excite, Info Seek, Lycos, Looksmart,
Miningco, Thunderstone, Web Crawler, and Yahoo.

The drawback to using metasearch service offered through Metacrawler is that your query
is reduced to its simplest form since numerous search engines offer different search rules.
Some of the results produced through Metacrawler will not be the same as going to a
individual search engine and crafting a query specific to the engine's rules.

Hands-on Hands-On Activity: Description:

1. Click in the Location toolbar
and type www.metacrawler.com
or metacrawler

2. Type computer aided drafting
instructional materials in the input
window.

3. Select All.

Displays the Metacrawler home page.

To find web pages containing all of
the words entered in the input
window.

4. Select Search. To start the search process.

5. What were the results?

Hint: To use Metacrawler's advanced features, select Power Search from the left menu.

Challenge: If there is time remaining in the lesson, go back to Altavista's Basic Search
Tips located on pages 29 and 30 and experiment with some of the examples. Try to include
your occupational specialty in the search expressions.



How To Purchase Netscape 4.5

If you already have some form of dial-up connection with an e-mail account but no web
browser you may get Netscape from the following sources:

1. Connect to Netscapce's Web site by typing:

type ftp ftp.netscape.com
at the login id prompt, type anonymous
at the password prompt, type your e-mail address
type cd pub <press enter>
type cd communicator <press enter>
type cd 4.5 (or other version of your choice) <press enter>
type cd english <press enter>
type cd windows or cd mac <press enter>

for Windows users:
type cd windows95 NT (for windows users) <press enter>
type cd complete_install <press enter>
type cd cc32e45.exe <press enter>

Assuming that you are working in a Windows environment, the cc32e45.exe file will
save to your local hard drive. Once downloaded, select run from the Windows95 Start
menu. Locate the cc32e45exe file from the browse option and open the file for
installation.

Downloading Netscape using the method listed above is extremely slow and not
recommended. The following instructions are reommended for brand new installations
of Netscape.

2. From a computer with an existing web browser, go to
www.merchant.netscape.com/setstore/media.htm to order the Netscape CD -Rom for
$10.00.

3. Purchase a Web book which includes browser software on CD-Rom.

If you wish to update an existing copy of Netscape and you have a dial-up connection, you
may go directly to Netscapes home page and download the application by selecting the
Browsers link located at the upper part of the page. Click on the Download link located
under Computing and the Internet. Select the appropriate Web browser for your hardware
platform.
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Internet Sites of Interest to Educators

Name

College Information

Collegenet

Expan

Educational Databases

Eric Database

Eric-VocEd

Electric Library (research
and reference)

Government

PA Chamber of Commerce

Department of Education

Thomas Legislative Info

Job Search

America's Job Bank

Careerpath

Online Career Center

PetersonsEducation/
Career Center

Job Hunt

Address

www.collegenet.com

//cbwebl.collegeboard.org
/expan/mkt_coll
/html/expn_col.html

Description

College search

Admission information for
colleges.

www.ualr.edu/coedept/Bkmarks/ERIC.html

coe.ohio-state.edu/cete/ericacve/

www.elibrary.com

www.pachamber.org

http://www.ed.gov

thomas.loc.gov

www.ajb.dni.us

www.careerpath.com

www.occ.com

www.petersons.com

www.job-hunt.org

Information relative to
entrepreneurship, human
resources, OSHA, etc.

On-line employment service.

Collection of jobs
from major newspapers
and leading employer web On
sites. Resume building.

Job and Career Information

Education and Career
information

On-line job search resources
and services.



Job Search (Con't)

Name

Monster

CareerMosaic

Search Engines

Front Page's Collection
of Search Engines

AltaVista

Dejanews

Excite

Hotbot

Infoseek

Lycos

Metacrawler

Mining Company

Thunderstone

Yahoo

General Sites of Interest

Amazon

CD Now

Consumer World

CuisineNet Menus Online

Epicurious

Federal Express

Address

www.monster.com

www.careermosaic.com/

www.thefrontpage.com/
search/search.html

www.altavista.com

www.dejanews.com

www.exite.com

www.hotbot.com

www.infoseek.com

www.lycos.com

www.metacrawler.com

www.miningco.com

www.thundestone.com

www.yahoo.com

www.amazon.com

www.cdnow.com

www.consumerworld.org

www.menusonline.com

www.epicurious.com

www.fedex.com
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Description

On-line job search but state,
discipline, and experience
(entry level).

On-line job search. Also
focuses on College students.

Contains a unique collection
of search engines

Internet news groups

Books and Authors

Music and Videos

Consumer Information

Restaurant Menus

Recipes and Cooking tips

Federal Express Tracking



General Site of Interest (Con't)

Name

Find law

HealthAtoZ

Infospace White Pages

Mapquest

Microsoft

Parent Soup

Shareware

Tax Forms

Zip2 Yellow Pages

ZDNET Software Lib

United Parcel Service

U.S.Postal Service

Address

www.findlaw.com

www.healthatoz.com

www.infospace.com

www.mapquest.com

www.microsoft.comisupport

www.parentsoup.com

www.shareware.com

www.1040.com

www.zip2.com

www.zdnet.com.findit

www.ups.com

www.usps.gov
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Description

Legal Resources

Health Information

People finding tools

Maps and Driving Instructions

Microsoft Product Support

Parenting library

Software Shareware

Tax Information

Business Directory

Computer Hardware and
Software

UPS Tracking

Zipcode lookups



Collected Sites of Interest for Vocational Technical Education
prepared by the Center for Vocational Education of Temple

University

Teaching/Educator Resources

General education: This resource is useful for locating information on .a variety of
topics in education, such as teacher resources.

excite.netscape.com/education/k_12/teacher_resources/

www.yahoo.com/Education/

Specific education. This resource provides information on specific areas or subjects in
education, such as research or legislation in education. e. g., The "cross-site indexing"
project of the U.S.Department of Education which consolidates more than 150 education
sites, research clearinghouses, national research centers, and state departments of
education.

www.search.ed.gov/csi/voced.html

www.avaonline.org/ American Vocational Education web site

Specialized education: This resource contains information on specialized education,
such as vocational education or special needs education.

vocserve.berkeley.edu The National Center for Research in
Vocational Education

gopher://teach.virginia.edu University of Virginia's site for special
education

Teacher-centered education: These are resources that provide links and information on
instructional strategies for teachers, such as lessonplans, classroom management
techniques, and curriculum development.

ericir.syr.eduNirtual/Lessons/#Search/ ERIC's AskERIC Lesson Plans

www.teachnet.com/lesson.html Teacher Net

www .education.com /ed/letter.html)
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Occupational/Professional Resources

Occupational information (general). These resources provide information on general
occupational, professional and technical issues, such as policy statements, belief
statements, current trends and competency assessment standards.

www.acfchefs.org American Culinary Foundation

Occupational skill information: These resources provide technical information on
specific occupations, duties and tasks, such as technical specifications, performance skills
standards, and requisite tools for performing tasks.

www.bhphotovideo.com B&H PhotoNideo site

www.healthatoz.com Health Occupation information

vocserve.berkeley.edu NCRVE's Skills Standards web page

Career exploration: The resources located in career exploration sit provide
information relating to job opportunities, career awareness and employers' expectations of
the workforce.

www.pottstownschools.com/career Pottstown Schools site
/careers.htm

www.brynmawr.edu/CDO Bryn Mawr College's Career
/netresources.html Development andJob Resources web page
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Educator Resources

http://ideanet.doe.state.in.us/coop

http://www.ed.gov/offices/OVAE/

http://www.albany.edu/aaace/

http://www.acenet.edu

http://search.ed.gov/csi

http://ncrve.berkeley.edu

www.bpic.org

www.scholar.lib.edulejournals/JVTE/jvte.ht

www.classroomconnect.com

www .education.com /.ed /letter.html

www.teachers.net

www.teachnet.com

www.education.com

mustang.coled.umn.edu

ericir.syr.edu/About

yahoo.com/Education

www.1 21 .ed.psu.edu

gopher.//teach.virginia.edu

http://www.ed.gov/pro_info/At-Risk/

http: / /ww\v.rit.edu/ easi/

gopher://val-dor.cc.buffalo.edu

http://www/stemnet.nfica/Curriculum/

http://www.avaonling.org/

http : / /stats.bls.gov /ocohome.htm

http:excite.netscape.com/education/k-
127teacher-resources/

http://pegasus.cc.ucfedu/-sorg/vocation.ht
ml

http://www.astd.org/

Website for Cooperative Coordinators

US Department of Education Office of
Vocational Education/Adult Education

American Association for Adult and
Continuing Education

American Council on Education

Cross-site indexing

National Center for Research in Vocational
Education

Urban High Schools Network

Vocational curriculum

Materials for educators

Curriculum guidelines

Lesson plan

Classroom management

Curriculum and lesson plans

A Web Cruising Vehicle for Teachers

Educational Resources Information Center

Variety of educational topics

Professional Development

Special Education

Students At-Risk

EAST: Access to Info for Persons with
Disabilities

Cornucopia of disability information

Curriculum Resources

American Vocational Association

Occupational Outlook Handbook

Teacher Resources

Vocational Education Resources

American Society for Training &
Development
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http://www.stw.ed.gov/

http://proteas.client.uq.edu.au/profhtm

http://www.enc.org/online/ENC2214/2214.
html

education.incliana.edu/cas/tt/tthmpg.html

National School-to-Work Office

Teachers' Professional Resources

Implementing the professional standards for
teaching mathematics

Different styles of teaching and lessons

Professional/Occupational Resources

www.scoe.otan dni.us

http://www.mastertask.com

http://www.pneac.org

http://www.ccar-greenlink.org

http://www.epa.gov

www.cic.sop.cstb.fr/ILC/ISO/AP228/hva

www.natex.org

http://www.btw.com

http://www.okstate.edu/-animaci/breeds/

http://www.psi.org/

http://steps.atsi.edu

http://www.brynmawr.edu/CDO/netresources
.html

careerpassport.com

www.acfchefs.org

w-ww.usda.gov

www.fda.gov

www.epix.net-mdennis

www.Kodak.com

www.videomaker.corn

www.bhphotovideo.com

www.adboe.com
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Outreach & Technical Assistance Network

Troubleshooting guides for machinists

Printing/graphics

Automotive

Environmental Protection Agency

HVAC Engineers

North American Technician Excellence

Gardening & Landscaping Information

Breeds of Livestock

Professional Secretaries International

Skill Standards Network

Career Development and Job Resources on
the Internet

Identify career and educational opportunities

Culinary Arts

US Dept of Agriculture

Food and Drug Administration

Audio-Visual Communications

Photography products

Videomakers magazine

Technical specifications in a technically rich
trade area

Good source to keep up-to-date in the field



pubs.cmpnet.com/iw/680

www.cobol.com

www.eatright.org

www.members.aol.com/edapinc/home.html

www.nmsu.edu/Academic_Progs/Undergradua
te_Catalog_95_96/ch8/aena.html

wvw.healthatoz.corn

www.aap.org

www.siteit.com/ccni

www.bcm.tmc.edu/cnrc

www.acca.org

www.rses.org
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Way to keep up on which software programs
the giants of industry are using

For updating information on the COBOL
programming language

Understanding proper nutritional intake

Utilized for discussing or studying eating
disorders

Research the profession of nurse aides and
their responsibilities

Useful source to search for nursing standards

American Academy of Pediatrics

Child Care and Nutrition, Inc.

Children's Nutrition Research Center

Air Conditioning Contractors of America

Refrigeration Service Engineers Society



ABSTRACTS

ABSTRACTS

ABSTRACTS

ABSTRACTS
ABSTRACTS

A B S T R A C T S
ABSTRACTS

As you work with the Internet to explore areas of professional skill and knowledge in you
occupational speciality, you will find vast amounts of information. Some of this
information will be very useful to you and some will be of little or no use. Unfortunately,
you may sometimes find that a vast amount of the returns of your search efforts may
yield information that is not useful to your needs at all. This can be very frustrating.

In contrast, It is certainly rewarding when you do indeed have search results that are on
target and meet your needs, i.e.,contribute to your technical skill and knowledge, be
used to enhance your teaching, and ultimately benefit your students. This is valuable
and it is important to share this information with others in the form of an abstract.

The development of an abstract is a convenient way to capture the success of your
efforts in order to:

1. provide a vehicle to share this information with other teachers with similar
needs and interests,

2. list the key points of what you have found on the Internet and describe their
importance,

3. describe how you were able to incorporate this information in the instructional
process to benefit your students, and

4. provide an opportunity to establish networks among individuals for future
collaboration.

The next 2 pages provide guidelines for completing an abstract as well as a form that
provides a structure for the development of an abstract. Please consider sharing the
success you have had in your vocational classroom/laboratory as a result of searching
the Internet by completing an abstract. All abstracts submitted will be placed on the
Internet in order to share this valuable information with others. After editorial review,
abstracts may be edited in order to maintain constancy in format, style and grammar.
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Guidelines for Completing Technical Skill/Knowledge Updating Abstracts

The Internet provides an exciting and powerful source of information that could be used
to assist in meeting your technical skill and knowledge updating needs as a vocational
teacher. Information may be found in any of the following categories:

General information

Product information

Manufacturers of equipment

Manufacturers specifications

Training resources

Training sites

On-line training

Trade and professional organizations

Organizations and/or individuals using new technology

Other vocational teachers

Specialized list serves or web sites

Standards

Other

Once identified through a search on the Internet, any of these leads can be pursued,
(on the Internet, or by direct personal contact ), in order to further your professional
development.

Use the attached Abstract of Technical Skill/Knowledge Update form as a guide as well
as a means of recording your efforts as you go through the process of searching the
Internet and following-up on information identified for your professional development.
Attach supplemental information such as lesson plans, information sheets or job sheets
and such as needed. Completed abstract forms will be compiled in a resource booklet
and, at a later time, serve as a data set for a possible web page on vocational teacher
skill/knowledge updating.

Send completed abstracts with any attachments to Dr. Chester P. Wichowski, The
Center for Vocational Education, Temple University RH-356, 1301 Cecil B. Moore
Ave.,Philadelphia, PA 19122 or chetvm.temple.edu
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- ABSTRACT OF TECHNICAL SKILL/KNOWLEDGE UPDATE -

Occupational Area: Topical Area:

Objective:

A: URL and description of information found useful to your needs on the Internet:

B: Action plan for professional development:

C: Description of curricular or instructional application:

D: Educational impact on students:

Submitted by: Date:

School: Phone / e-mail:

Send completed abstracts with any attachments to Dr. Chester P. Wichowski,
The Center for Vocational Education, Temple University RH-356,
1301 Cecil B. Moore Ave. Philadelphia, PA 19122 or chet@vm.temple.edu
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